
Drawing Paths

Photoshop provides several methods for isolating areas of an image, as you saw

in Chapter 5, “Making Selections.” Still, making accurate selections can be difficult or

time-consuming, because each image presents different problems. The Pen tool and the

Paths palette add capabilities to further enhance the accuracy and speed of making selec-

tions and defining the smooth edges. After you’ve learned to draw with the Pen tool, you’ll

probably find it indispensable, because it can often be the easiest and fastest way to select

areas that are defined by long, smooth curves.

Photoshop also offers several other vector-generating tools that are used for making

lines and shapes.

This chapter will cover topics including:

■ Using the Path tools and the Paths palette

■ Drawing and editing paths

■ Using paths to apply color

■ Converting, importing, and exporting paths

■ Using vector masks and clipping paths

■ Using the Shape tools
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What Is a Path?
If you have used any vector illustration software, the Paths function in Photoshop should

be familiar to you. Paths represent vector objects that mathematically define specific areas

on an image by virtue of their shape and position. Vector objects are composed of anchor

points and line segments, known as Bezier curves, like the ones shown in Figure 8.1. (See

Chapter 2, “The Nature of the Beast,” for more information on these terms.)

The Path tools enable you to create straight lines and curves with much greater clarity

and precision than the selection tools. If you create an open-ended path, you can then

stroke it with a color to form a curved line (using the path as a drawing tool). If its two

end points have joined, the path encloses a shape. You can then fill the shape with color,

stroke it with an outline, or store it in the Paths palette (or the Shape library) for later use.

It can also be converted into a selection, to which you can then apply some other Photo-

shop operation.

The Path Tools
The primary Path tool is the Pen tool, located in the Tool palette. To choose the Pen tool,

click its icon or press P. If you hold down the mouse button, you can expand the Tool

palette to display the other Path tools. Photoshop has tools for drawing paths (Shift-P 

cycles through these) and tools for editing paths (Shift-A cycles

through these). Two tools are designed specifically to select and

move a path or a portion of a path. You’ll explore these tools

throughout the chapter, but here is a quick preview.

Path-Drawing Tools
This set of tools includes the following:

The Pen tool draws paths by clicking and dragging.

Line Segment

Anchor Point
Direction Handle

Figure 8.1

Components of
Bezier curves
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The Freeform Pen tool draws a freeform line that converts itself into a path

when the mouse is released.

The Freeform Pen tool with the Magnetic option, sometimes simply

called the Magnetic Pen, intuitively defines edges based on contrasting colors.

Path-Editing Tools
This set of tools includes the following:

The Add Anchor Point tool adds anchor points to existing paths.

The Delete Anchor Point tool removes anchor points from existing paths.

The Convert Point tool changes a corner point to a curve or a curve to a 

corner point.

The Path Selection tool selects and moves the path as a unit.

The Direct Selection tool selects and moves individual anchor points and 

segments.

Drawing Paths
Each path-drawing tool employs a slightly different method for creating a path outline.

Learning to draw accurately with the Pen tools can be challenging at first, because drawing

with Bezier curves is unlike any form of traditional drawing. With a little practice, however,

your speed and accuracy will improve considerably.

The Pen Tool
The Pen tool enables you to draw straight lines and smooth curves with a high degree of

control and precision. The basic techniques and concepts used for drawing paths in Adobe

Photoshop closely parallel those used in Adobe Illustrator. Usually, a path is drawn to fol-

low the form of the area to be isolated, and then the path is edited and refined to a consid-

erable degree of accuracy.

The Pen Tool Options bar displays options that let you modify the tool’s behavior

(see Figure 8.2). Before you draw a path or a shape, specify in the Options bar whether to

make a new Shape layer or a new work path. This choice will affect how the shape can later

be edited. If you choose the Shape Layer icon, Photoshop generates an independent Shape

layer (see the “Creating Lines and Shapes” section near the end of this chapter). If you

choose the Work Path icon, Photoshop draws an independent path and creates a work

path in the Paths palette. For now we’ll be working with work paths. Select the Auto

Add/Delete check box to automatically add anchor points when one of the Pen tools is

placed on a segment or to delete a point when a Pen tool is placed over an anchor point.
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When you choose the Pen tool, you have a choice of four behaviors represented by the

four icons on the right side of the Options bar. Use them to add to an existing path, sub-

tract from an existing path, intersect with an existing path, or exclude overlapping path

areas. The results of these operations can be seen when a fill is applied to the path.

Straight Paths
The simplest of all paths consists of two anchor points joined by a straight line segment.

(Anchor points that connect straight line segments are called corner anchor points.) You

add segments to the straight path by moving the cursor and clicking the mouse. The seg-

ments can abruptly change direction as the corners zigzag their way across the image.

Take these steps to draw a straight path:

1. Select the Pen tool and click the image where you want to begin the path. An anchor

point appears; release the mouse button.

2. Click (and release) your mouse at the next point on the image. A line segment with

another anchor point appears between the two points.

3. Continue to move and click your mouse to produce a series of straight-line segments

connected by corner anchor points.

Curved Paths
A curved path consists of two anchor points connected by a curved segment. Direction

handles determine the position and shape of the line segment.

Take these steps to draw a curved path:

1. Select the Pen tool and place the cursor over the image where you want the path to begin.

If you want the Pen tool to make only vertical or horizontal lines, hold down the Shift key

while you draw.

Using the Zoom tool or the Navigator to view the image more closely greatly enhances your

ability to draw with precision.

Displays 
Geometry
OptionsShape ToolsPen Tool

Freeform
Pen Tool

Automatically Adds or 
Deletes Anchor Points

Intersect
Path Area

Add to
Path Area

Subtract
from Path Area

Exclude 
Overlapping 
Path Areas

Selects a
Tool Preset

Creates a
New

Work Path

Creates a
New Shape Layer

Create
Fill Pixels

Figure 8.2

The Pen Tool
Options bar
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2. Click your mouse and drag. An anchor point with a direction handle appears. Without

releasing the mouse button, drag the handle in the general direction you want the curve

to travel.

3. Release the mouse and move the cursor to the next point on the image.

4. Click your mouse and drag. A curved segment with another anchor point and direc-

tion handle appears. Drag in the opposite general direction of the curve.

5. With the mouse button still pressed, adjust the direction handle until the curved line

segment is in the desired position, and then release the mouse.

Tips for Drawing Curved Paths

Keep the following suggestions in mind as you practice drawing curved paths:

• Drag the first point in the direction of the peak of the curve, and drag the second 

point in the opposite direction. Dragging the first and second point in the same

direction produces an S curve, which is undesirable because its shape is difficult

to control.

• Use as few anchor points as possible to ensure a smooth path.

• Place the anchor points on the sides of the curve, not on the peaks or valleys, to main-

tain better control and smooth transitions.

• A path is a continuous series of segments connected by anchor points. You can add

anchor points to the middle of a segment, but you can add segments only to the end

points of an open path.

• An anchor point can connect only two segments.

• If you stop drawing and want to add a new segment to a path, resume drawing by first

clicking one of the end points with a Pen tool.

• If you are drawing an open path and want to begin a second path that is not con-

nected to the first, press Ctrl (Windows) or F (Macintosh) to start the Direct Selec-

tion tool. Click off the path and release the key. Resume drawing the new path.

Changing the Direction of a Curved Path

You can draw a scalloped path by changing the direction of the curve. When performing

this operation, it helps to think of the Alt/Option key as a turn signal. In the following

example, the segments will curve upward. Follow these steps:

1. Select the Pen tool. Click the image where you want to begin the path and drag up. An

anchor point with a direction handle appears. Without releasing the mouse button,

drag to adjust the direction handle; then release.
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2. Click where you want the next part of the curve. Click your mouse and drag down. A

curved segment with another anchor point and direction line appears, as in Figure 8.3;

release the mouse.

3. Place your cursor on the last anchor point and press Alt/Option (the turn signal!). 

See Figure 8.4.

4. Click and drag the direction handle up and release the mouse (see Figure 8.5).

5. Move your cursor to the next location, click your mouse, and drag down. Adjust the

segment so that the curve is the desired length and position (see Figure 8.6).

6. Repeat steps 3 and 4.

7. Repeat steps 2 through 5 until the desired number of curves are drawn (see Figure 8.7).

Adding a Curved Path to a Straight Path

Usually, the paths you draw are combinations of straight and curved paths. These tech-

niques combine the two into one continuous path:

1. Select the Pen tool and click the image where you want to path to begin. An anchor

point appears; release the mouse button.

2. Click the next point on the image. A straight segment with another anchor point

appears.

3. To add a curved segment, place your cursor on the last anchor point, and press

Alt/Option while holding down the mouse button and dragging up.

4. Release your mouse button and move your cursor to the next location.

5. Click your mouse and drag down to finish the curve. Release the mouse when the size

and position of the curve are achieved (see Figure 8.8).

Adding a Straight Path to a Curved Path

You can also begin with a curve and add a straight line to it:

1. Select the Pen tool, click the image where you want to begin the path, and drag up. An

anchor point with a direction handle appears. Without releasing the mouse button,

drag the direction handle in the direction of the curve.

2. Release the mouse and move the cursor to the next point.

Figure 8.8

Adding a curved segment to a
straight segment

Figure 8.7

Repeat to draw more curves.
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A curved segment
with another 

anchor point and
direction line

Figure 8.4

Placing the cursor
on the last anchor

point and pressing
Alt/Option

Figure 8.6

Drag and adjust to
the desired position.

Figure 8.5

Dragging the 
direction handle up
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3. Click your mouse and drag down. A curved segment with another anchor point and

direction line appears. Release the mouse.

4. Place your cursor on the last anchor point, press Alt/Option, and click your mouse

once.

5. Move your cursor to the next location and click your mouse to complete the segment.

Closing a Path

By closing a path, you create a shape. To close a series of straight paths, draw at least

two paths, and then place your cursor directly over the first anchor point. A little circle

appears beside the pen cursor to indicate that the path is ready to be closed. Click the

mouse. To close one or more curved paths, draw at least one path and click the first

anchor point.

The Freeform Pen Tool
Drawing with the Freeform Pen tool is similar to drawing with the Lasso tool, introduced

in Chapter 5. If you place your cursor on the image, click, and drag your mouse, the

Freeform Pen will be followed by a trail that produces a path when the mouse is released

(see Figure 8.9).

The Freeform Pen tool provides a quick way to draw a curve, but it doesn’t offer the

same level of control and precision as the Pen tool. You can’t control the number or place-

ment of anchor points. Paths created by the Freeform Pen usually require editing or

removal of excess anchor points after the path has been completed.

When you select the Freeform Pen tool, the Options bar provides new settings in the

Freeform Pen Options drop-down menu: Curve Fit and Magnetic. You can specify the

Curve Fit between 0.5 and 10.0 pixels, to determine the sensitivity of the tool to the move-

ment of your mouse. A lower tolerance produces a finer curve with more anchor points. A

higher tolerance produces a simpler path with fewer anchor points, and fewer anchor

points produce a smoother curve.

The Magnetic Pen Option
The performance of the Freeform Pen tool with the Magnetic check box selected (also

called the Magnetic Pen tool) is similar to the Magnetic Lasso (see Chapter 5). It automat-

ically snaps to areas of high color contrast within an image as you drag. You define the

area within which snapping will occur and the degree of contrast needed to trigger snap-

ping. Whereas the Magnetic Lasso converts to a selection, the Magnetic Pen converts to a

path. Thus, the Magnetic Lasso is a good tool for cropping, say, a face out of a contrasting

background, and the Magnetic Pen is useful for defining its edges based on contrasting

colors.
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To access the Magnetic Pen, select the Freeform Pen tool (click and hold the cursor on

the Pen tool in the Tool palette, and choose the Freeform Pen from the fly-out; or press

Shift-P once or twice to select the tool) and select the Magnetic check box in the Options

bar. Then use the Freeform Pen Options menu to display the Magnetic options:

Width Enter a distance in pixels from the edge that the tool will be active. Higher values

mean the tool is “attracted” to the edge from a greater distance.

Contrast Enter a value between 1% and 100% to determine the tool’s sensitivity in detect-

ing contrasting borders. Higher values detect edges of greater contrast, and lower values

increase the tool’s sensitivity to low-contrast edges.

Frequency Enter a value between 1 and 100 to establish the rate at which the Magnetic

Pen places anchor points. Higher values place more anchor points over a shorter distance.

Pen Pressure If you are working with a stylus tablet, check Pen Pressure. As you drag, the

pressure of the stylus will correspond to the Width setting. An increase of pressure on the

stylus will extend the range—or width—of the magnetic sensitivity of the pen.

Open the file el_jefe.psd in the Chapter 8 folder on the CD. You can use this image to

practice the Path and Shape tool techniques described in this chapter.

Take the following steps to draw with the Magnetic Pen:

1. Click the image to set the first point, near an edge of relatively high contrast.

2. Release the mouse button and drag slowly. A path will follow along the most distinct

edge within the Pen width. Periodically, the Pen places anchor points along the speci-

fied border, while the most recent segment remains active (see Figure 8.10).

3. Press Enter/Return to end an open path. You can resume drawing the open path by

clicking the last anchor point and dragging.

4. If you stop dragging and double-click, you create a segment that connects the last

anchor point with the first one and closes the path. You can also close the path by

hovering over the first anchor point until the little circle appears. Click once.

You can temporarily turn off the Magnetic option by holding down the Alt/Option key with

the mouse button pressed to draw a straight path, or with the mouse button released to

draw a freeform path.

You can increase the detection width in one-pixel increments while drawing by pressing the ]

key. You can decrease the width by pressing the [ key.
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Editing Paths
After a path has been drawn, all or part of it can be moved or reshaped. Anchor points 

can be added or omitted, and corners can be converted into curves or curves into cor-

ners. Paths can also be transformed and combined.

The path-editing tools include the Path Selection tool, the Direct Selection tool, the

Add Anchor Point tool, the Delete Anchor Point tool, and the Convert Point tool.

Using the Path Selection Tool
The black arrow, the Path Selection tool, selects all the anchor points and segments of a

path. You can then reposition the path anywhere on the image by dragging it with this tool.

You can duplicate a path by dragging and dropping it with the Path Selection tool and

the Alt/Option key pressed (see Figure 8.11).

Aligning Paths

By using the Path Selection tool, you can automatically align and distribute multiple paths

and vector objects such as lines and shapes. You cannot, however, align or distribute shapes

that are on separate layers. To align multiple paths, select two or more paths with the Path

Selection tool by dragging a marquee that touches the objects or by Shift-clicking the

paths. From the Options bar, choose one of the alignment options shown in Figure 8.12.

Figure 8.11

Alt/Option-drag with the Path Selection
tool to duplicate a path.

Figure 8.10

A path made with the Magnetic Pen
“snaps” to a line of contrasting pixels.

Another method of selecting a path is to use the Path Selection tool and click and drag a mar-

quee that touches any part of the path. All the anchor points will appear solid, indicating that

the entire path is selected.
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The Align choices match up the edges or centers of paths and objects, as follows:

Top Edges Aligns the top edges of the path or vector object

Vertical Centers Aligns the vertical midpoints

Bottom Edges Aligns the bottom edges

Left Edges Aligns the left edges

Horizontal Centers Aligns the horizontal midpoints

Right Edges Aligns the right edges

The Distribute choices position the edges or centers of paths and objects over equal dis-

tances, in these ways:

Top Distributes the top edges of the path or vector object

Vertical Centers Distributes the vertical midpoints

Bottom Edges Distributes the bottom edges

Left Edges Distributes the left edges

Horizontal Centers Distributes the horizontal midpoints

Right Edges Distributes the right edges

Figure 8.13 illustrates the difference between aligning and distributing.

Using the Direct Selection Tool
The Direct Selection tool selects or modifies a segment, or the position of an anchor point,

on a path. It is an essential tool for revising and reshaping a path after it has already been

drawn.

To select, move, or edit a segment or an anchor point, choose the Direct Selection tool.

Click a segment or an anchor point to select it. Click and drag an anchor point to reposi-

tion it or a segment to reshape it. To deselect a path, click anywhere on the image.

You can toggle from any of the Pen tools or path-editing tools to the Direct Selection tool by

pressing the Ctrl/F key.

Align
Top

Edges

Distribute
Right
Edges

Distribute
Horizontal

Centers

Distribute
Left

Edges

Distribute 
Bottom 

Edges

Distribute
Vertical
Centers

Distribute
Top 
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Align
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Edges
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Horizontal
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Left
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Edges
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Figure 8.12

Alignment 
features of the 

Path Selection tool
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Reshaping Paths

To alter the shape of a path after it has been drawn, follow these steps:

1. Choose the Direct Selection tool.

2. Click an anchor point to select it.

3. Click and drag one of the anchor point’s direction handles until the desired shape of

the curve is achieved (see Figure 8.14).

Editing Anchor Points
After you have drawn a path around an area on the image, you might need to refine it by

adding or deleting anchor points. When you do so, you increase your ability to edit the path.

It might be tempting to add dozens of anchor points, to facilitate the drawing of a path.

That’s not always a good idea, because too many extra points increase the path’s complex-

ity and compromise the smoothness of the shape.

Adding and Deleting Anchor Points

To add an anchor point, select the Add Anchor Point tool and click the path. A new

anchor point will appear where you’ve clicked. To delete an anchor point, select the Delete

Anchor Point tool and click an anchor point. The two segments connected by the point

will join into one.

Converting Anchor Points

There are two types of anchor points. Smooth points connect curved or straight lines

that “flow into” each other. Corner points connect lines that change direction abruptly.

You can convert an anchor point from corner to smooth or from smooth to corner by

clicking the point with the Convert Point tool (see Figure 8.15). Click a smooth point,

and it converts to a corner point; to convert a corner point, click it and drag out the

direction handles until the desired curve is achieved, and release the mouse.

Transforming Paths
Like selection outlines and selection contents, paths can be modified with the transforma-

tion tools. After a path has been drawn, you must select it with one of the arrow tools. If you

select it with the Path Selection tool, you can employ any of the transformation operations

in the Edit menu (including Free Transform, Scale, Rotate, Skew, Distort, Perspective, or Flip)

to edit the entire path. If you select one or more points or segments with the Direct Selection

tool, you can apply any of the transformation operations to the selected part of the path.

To learn how to use Photoshop’s transformation features, see Chapter 12, “Sizing and Trans-

forming Images.”
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Reshaping a path

Figure 8.15

Converting (top) a
corner to a smooth
point and (bottom) 
a smooth to a corner
point
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Combining Paths
If you have drawn two or more paths that intersect, you can combine them into one path.

Select both paths with the Path Selection tool by clicking your mouse button and dragging

a marquee that touches both of them or by clicking them in sequence while pressing the

Shift key. On the Options bar, click the Combine button. The elements of both paths

combine into a group of paths. Clicking any member of the group with the Path Selection

tool selects all of them.

The Paths Palette
The Paths palette is the central control for all path operations. Like a layer or a channel, a

path can be stored into a palette so it can later be edited or converted into a selection. You

access the Paths palette by choosing Window ➔ Paths (see Figure 8.16). If you still have the

Paths palette in the default cluster—grouped with the Layers palette—pressing the F7

function key will also open it.

Work Paths
When you begin drawing a path with the Pen tool, it appears in the Paths palette as a

thumbnail named Work Path. The work path is a temporary element that records changes

as you draw new sections of the path. If you complete a path on an image, click the Pen

tool, and draw another path, it will appear on the same Work Path thumbnail as the first

path. To create separate additional paths, you must save the work path to the Paths

palette.

You can increase or decrease the size of the Paths palette thumbnails, or turn them off,

by choosing Palette Options from the palette drop-down menu and clicking the radio but-

ton next to the desired thumbnail size.

Fill Path

Delete Path
New Path

Make Work Path from Selection
Load Path as Selection

Stroke Path

Figure 8.16

The Paths palette
and its menu
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Saving Paths
Saving a path to the Paths palette has a distinct advantage over saving selections as alpha

channels (which are described in Chapter 11, “Using Channels and Quick Mask”): the file

size of a document does not substantially increase with each saved path.

After your path has been drawn and appears as a Work Path thumbnail, you can save it

by choosing Save Path from the palette menu. A dialog box appears in which you can name

the path; if no name is entered, the path name defaults to Path 1. You can also save a path

by dragging the Work Path thumbnail to the New Path icon at the bottom of the

palette.

The Paths palette lists saved paths from top to bottom in the order in which they were

created. You can reorganize the paths in the list by clicking the path’s name or thumbnail

and dragging it to the desired location.

Displaying Paths
To display a path, click the path’s name or thumbnail image in the Paths palette. Photo-

shop allows only one path to be displayed at a time. When displayed, it will appear on the

image. You can edit it, move it, add other paths to it, or delete portions of the path. To

conceal a work path or saved path from view in the image window, click the empty por-

tion of the Paths palette.

Deleting Paths from the Image Window
To delete a path from the image, do one of the following:

• Select an entire path with the Path Selection tool. Press the Delete/ Backspace key. If

it’s a work path, the path and its icon are deleted. If it’s a saved path, the path is deleted

from the image window, but its empty thumbnail remains in the Paths palette.

• Select a part of the path with the Direct Selection tool. Press the Delete or Backspace

key once to delete the selected part of the path or twice to delete the entire path.

Deleting Paths from the Palette
You might want to discard a path from the Paths palette after you are sure you will have

no further use for it. To do so, target the path’s name in the palette and perform one of the

following operations:

• Drag the path thumbnail to the trash icon at the bottom of the palette.

• Choose Delete Path from the Paths Palette drop-down menu.

• Click the trash icon in the Paths palette. In the dialog box that opens, click Yes.

• Target the path in the Paths palette. Press the Delete or Backspace key.
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Using Paths to Apply Color
You can apply color to an area of an image within a closed path or to the edge of a path.

Filling a Path
To fill the area within a path, follow these steps:

1. Draw an open or closed path or display an existing path from the Paths palette by

clicking its thumbnail.

2. Choose a foreground color and then choose Fill Path from the Paths Palette drop-

down menu to open the Fill Path dialog box (see Figure 8.17). Its Contents and

Blending areas are identical to the Fill dialog box accessed from the Edit menu and

are discussed in Chapter 9, “Creating and Applying Color.”

3. In the additional Rendering field, you can enter a feather radius for the edges of the

path and select the Anti-Aliased check box. Click OK when you have the settings 

you want.

You can fill a path with the current Fill Path dialog box settings by clicking the Fill Path

icon at the bottom of the Paths palette.

Stroking a Path
A path can be stroked with a line of a specific color and width. This is an important opera-

tion in Photoshop because it is really the only way to create smooth, curved lines precisely.

Try drawing one with the Paintbrush or Pencil; you’ll see that it’s quite difficult to achieve

satisfactory results. Drawing an open path, editing it to your exact specifications, and then

stroking it with a color produces perfect results every time.

Figure 8.18

The Stroke Path dialog box

Figure 8.17

The Fill Path dialog box
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To color the line of a path, first follow these steps:

1. Draw a path or load one from the Paths palette.

2. Choose a foreground color from the Color Picker, Swatches palette, or

Color palette.

3. From the Paths Palette menu, choose Stroke Path to open the Stroke

Path dialog box (see Figure 8.18).

4. Select a tool from the Tool list.

5. After you click OK, the stroke is painted with the current characteristics

of the chosen tool as defined in the Options bar.

You can quickly stroke a path with the current tool characteristics set in

the Stroke Path dialog box by clicking the Stroke Path icon at the 

bottom of the Paths palette. Figure 8.19 shows an example.

Converting Paths
The primary reason for using paths is the ease and facility with which you can precisely

define regions of an image. Although some of the selection tools offer unique selection

techniques, there is nothing quite like the path operations to quickly and precisely sur-

round an area.

Paths are easy to edit and require less real estate on your disk than selections saved as

alpha channels. Eventually, though, you will need to convert your path into a selection

before you can apply a Photoshop operation to the area it surrounds.

Converting a Path into a Selection
When you convert a path to a selection by using the Make Selection dialog box, you can

specify the characteristics of your new selection and its relation to active selections on the

image. To do this, target the path in the Paths palette and choose Make Selection from the

Paths Palette drop-down menu. The Make Selection dialog box opens, in which you can

choose the characteristics of the new selection:

Feather Radius Sets a distance in pixels for feathering of the selection outline

Anti-Aliased Determines whether the selection will possess an anti-aliased edge

New Selection Makes a selection from the path

Add To Selection Adds the area defined by the path to the active selection

Subtract From Selection Omits the area defined by the path from the active selection

Intersect With Selection Makes a selection from the overlap of the path and the active selection

Click OK to convert the path into a selection.

Another way to convert a path into a new selection is by clicking the Load Path As

Selection icon at the bottom of the Paths palette.
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Converting a Selection into a Path
To convert a selection into a path, draw a marquee with one of the selection tools. Choose

Make Work Path from the Paths Palette menu. A dialog box is displayed that enables you

to set the tolerance of the path in pixels. Tolerances with low values produce more-com-

plex paths with greater numbers of anchor points, whereas tolerances with higher values

produce simpler paths. Click OK to convert the selection into a path.

You can also convert a selection into a path by clicking the Make Work Path From

Selection icon at the bottom of the Paths palette.

Importing and Exporting Paths
Photoshop paths can be used by other programs, where they can be modified. You can

transfer a path directly from Photoshop to popular vector-based drawing programs such

as Illustrator or FreeHand, or vice versa, to take advantage of either program’s unique

path-editing features.

Copying and Pasting
If you’re moving the path from Photoshop to a vector-based drawing program, you can

select the entire path with the Path Selection tool and copy it to the Clipboard (by choos-

ing Edit ➔ Copy or pressing Ctrl/F-C). Open a document in the other program and

paste the path into it. The paths remain fully editable in either program.

When you paste a path from a drawing program into Photoshop, the Paste dialog

box opens, asking you to choose to place the path as a rasterized image (pixels), a

vector path, or a Shape layer (see Figure 8.20).

Dragging and Dropping
You can drag and drop a path from Photoshop to Illustrator. With both programs run-

ning, select the path with the Path Selection tool. Drag the path onto the Illustrator paste-

board. The new Illustrator path is fully editable.

Exporting Paths to Illustrator
If you can’t run Photoshop and Illustrator simultaneously, you can export the file as a

native Illustrator format (.ai) file by choosing File ➔ Export ➔ Paths To Illustrator. In the

dialog box that opens, choose Work Path from the Write menu. After you quit Photo-

shop, launch Illustrator, and open the document, the exported path will be fully editable

in Illustrator.

Paths exported from Photoshop to Illustrator do not contain fill or stroke information.
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The Paste dialog box
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Using Vector Masks
When working with Photoshop graphical elements, it is sometimes necessary to “knock

out” portions of an image—that is, make those areas invisible so that elements in layers

below can show through. You do so using a vector mask. When you use a vector mask, the

interior portion of the path will be displayed, and the area outside the path will be com-

pletely transparent (for more about layer masking, see Chapter 20, “Advanced Layer

Techniques”). Vector masks are best used when you want a clean, crisp edge to your 

element—not always easy to create with regular selection methods!

To create a vector mask:

1. Open el jefe.psd in the Chapter 8 folder on the CD.

2. In the Layers palette, double-click the background to make it into a layer. Name the

layer Head.

3. Choose the Freeform Pen tool. In the Options bar, check the Magnetic option. and

click the Paths icon. Draw a path around El Jefe’s head with the Pen tool to isolate it

(see Figure 8.21). Use the Direct Selection tool to tweak it for accuracy.

4. From the Paths Palette drop-down menu, choose Save Path, and name it Vector Head.

5. With the path selected in the Paths palette, choose Layer ➔ Add Vector Mask ➔

Current Path from the Palette menu.

6. The path outline will clip out anything outside the path, making it invisible and let-

ting any layer beneath show through. The vector mask is also represented in the Lay-

ers palette, to the right of your active layer. At this point you can refine the path even

further with the Path Selection tool to produce an even more accu-

rate mask. Notice also that you can apply a layer style such as the

Drop Shadow (shown in Figure 8.22) with vector masks.

7. Click the New Layer icon at the bottom of the Layers palette.

Choose a foreground color and press Alt/Opt-Delete/Backspace to

fill the new layer with the color. Drag the new layer under the

Head layer.

8. To add the star, draw it with the Pen tool, and repeat steps 2, 3,

and 4. You can add the text or any other graphic elements, the

choice being limited only by your imagination! Figure 8.23 shows

the completed image.
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Figure 8.21

Selecting the area
with the Freeform
Pen tool with the
Magnetic option
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Using Clipping Paths
The Clipping Path option has essentially the same effect as the Vector Mask option, except

that clipping paths are designed to be exported with your image into a vector illustration

program (such as Adobe Illustrator) or a page layout program (such as Adobe InDesign)

instead of embedded within a Photoshop layer.

To create a clipping path, follow these steps:

1. Create a path around an area of your image as before by using the Path tools.

2. From the Paths Palette drop-down menu, choose Save Path, and give it a name.

3. Choose Clipping Path from the palette menu to open the Clipping Path dialog box

(see Figure 8.24).

4. Select the name of the path you want to convert to a clipping path from the Path list.

Click OK.

Figure 8.22

Applying a Drop
Shadow layer style

Check the Options bar to be sure the Path option is chosen (not Shape Layers or Fill Pixels)

and the Exclude Overlapping Path Areas option is also chosen (not the Add/Subtract/Inter-

sect options). If these two settings are inactive, users wanting to create simple compound

clipping paths are often confused.
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5. For most paths, leave the Flatness setting blank. When you print the image, the

printer’s default flatness setting will define the shape. However, if you experience

printing problems, try saving the path with new settings (see the “Troubleshooting

Clipping Path PostScript Errors” sidebar).

Images containing clipping paths must be saved in either EPS or TIFF format, depend-

ing on the program, and therefore can be imported only into programs that support these

image formats. It’s best to save a copy of the image so that the original image retains Pho-

toshop’s attributes.

To save an image with a clipping path as an EPS, follow these steps:

1. Choose File ➔ Save As. Check the As A Copy box.

2. From the Format list, choose Photoshop EPS to open the EPS

Options dialog box (see Figure 8.25).

The path name is boldfaced in the Paths palette, indicating that it is a clipping path.

Figure 8.23

The finished image
with the vector
mask’s thumbnails
in the Layers palette
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Figure 8.24

The Clipping Path
dialog box
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3. Choose a Preview option, depending on the type of computer and the platform you

are using: Macintosh or Windows, 1 bit or 8 bit.

4. For the Encoding type, choose Binary.

5. Click OK.

6. Open a document in a desktop-publishing program or vector-drawing program, and

place the EPS image. The clipping path will mask out everything outside the path,

much the same as the vector mask does within Photoshop.

Creating Lines and Shapes
Photoshop handles lines and shapes in a manner much like Illustrator. Like type, lines and

shapes are vector objects (drawn and defined by paths). You draw a predefined shape by

using one of the Shape tools, or you draw a custom shape by using the Pen tool. Once

drawn, shapes can be edited by adjusting their anchor points with the path-editing tools.

When you create a shape on a Shape layer, it appears on an independent layer with a

Vector Mask thumbnail next to a Color Fill Layer thumbnail.

The shape also appears as a separate path in the Paths palette.

To apply any filter to a shape, it must first be rasterized, or turned

into pixels. If you flatten the image, shapes are automatically con-

verted to pixels.

The Shape tool can instantly create precise shapes, such as rectangles, rounded rectan-

gles, ellipses, polygons, lines, and custom shapes that you can edit with the path-editing

tools. When you click the Shape tool in the Tool palette, it expands to reveal all the avail-

able tools. After you’ve chosen a shape from this fly-out, click in the image and drag to

size the shape.

Figure 8.25

The EPS Options 
dialog box
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The Shape Tool Options Bar
As you choose a different shape from the Tool palette or from the Shape list in the

Options bar, the Options bar changes to accommodate specific characteristics of the

shape. Figure 8.26 illustrates the differences in the Options bar when the three drawing

options are selected.

T R O U B L E S H O O T I N G  C L I P P I N G  P A T H  P O S T S C R I P T  E R R O R S

A raster image processor (RIP) is software on a computer, or a device inside an imagesetter

or PostScript printer, that interprets a vector curve by connecting a series of straight line

segments together. The flatness of a clipping path determines the fidelity of the lines to the

curve. The lower the setting, the more lines are produced, and the more accurate the curve.

But if a clipping path is too complex for the printer’s capabilities, it cannot print the path

and will produce a limit check or PostScript error. Any printer can be jammed up with a com-

plex clipping path, although you might find that a clipping path will print perfectly well on a

low-resolution printer (300–600 dpi) because that device uses a higher flatness value to

define the curve. The same clipping path might not print on a high-resolution imagesetter

(1200–2400 dpi). If you run into printing problems on an image with a clipping path, trouble-

shoot them in the following ways:

• Increase the Flatness settings and resave the file. Flatness values range from 0.2 to 100.

Enter a Flatness setting from 1 to 3 for low-resolution printers and from 8 to 10 for high-

resolution printers.

• Reduce the number of anchor points in the curve by manually eliminating them with

the Delete Anchor Point tool.

You can also re-create the path with lower Tolerance settings:

1. Target the path in the Paths palette.

2. Click the Load Path As Selection icon at the bottom of the palette.

3. Click the trash icon to delete the path but leave the selection.

4. Choose Make Work Path from the palette menu. In the dialog box, decrease Tolerance

to 5 pixels (a good place to start).

5. Name and save the new work path.

6. Choose Clipping Path from the palette menu.

7. Save the file in EPS format.
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The Options bar features are as follows:

Options Bar Feature Function

Shape Layers Makes a shape and a path on a new layer

Paths Makes the path outline of the shape on an existing layer or background

Fill Pixels Fills an area with the foreground color in the form of the shape

Shape List Lets you choose a shape

Custom Shape Options Lets you enter specifications for the size and proportion of the shape

Style Attaches a layer style to the Shape layer (available with New Shape
Layer)

Shape Characteristics Assigns values for the characteristics of a particular shape or chooses a
custom shape

Mode Lets you select a blending mode for the shape (available only with
Create Fill Pixels)

Opacity Sets the opacity for the shape by moving the slider (available only with
Create Fill Pixels)

Anti-Aliased Applies an anti-alias to the shape (available only with Create Fill Pixels)

Drawing Shapes
To draw a shape, first choose a foreground color. Click the Shape tool in the Tool palette

and choose a tool type from the expanded palette or from the Options bar. Click in the

image and drag to form the shape.

Because shapes are vector objects, you can use the Path Selection tool, the Direct Selec-

tion tool, or the path-editing tools to move or edit a shape or to add and delete anchor

points.

Each shape performs slightly differently. The Options bar of each shape lets you adjust

its individual characteristics. For example, you can enter a value for the radius of the cor-

ners on the Rounded Rectangle tool or for the number of sides on the Polygon tool.

Shape Characteristics

Create Shape Layer

Create Fill Pixels

Create New Work Path

Figure 8.26

The Options bar of
the Shape tools
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The Rectangle Tools and Ellipse Tool

As with the marquee tools, icons on the Shape Tool Options bar let you add, subtract,

intersect, or exclude areas from a shape as you draw. Clicking the arrow to the right of the

Shape tool icons on the Options bar offers additional controls on a pop-up list. When you

choose the Rectangle, Rounded Rectangle, or Ellipse tool, the down-arrow button on the

Options bar offers you these choices:

Unconstrained Sizes and proportions the shape as you draw

Square (or Circle) Constrains the shape

Fixed Size Lets you sets values for the shape’s width and height

Proportional Uses Width and Height fields to define the shape’s proportion

From Center Radiates the shape from a center point

Snap To Pixels Aligns the shape to the on-screen pixels (Rectangle and Round Rectangle only)

The Polygon Tool

When you select the Polygon tool, a Size field in the Options bar lets you set the shape’s

number of sides. The Polygon Options panel choices differ from those of the other shapes.

Figure 8.27 illustrates the variety of shapes you can create by adjusting these settings:

Radius Enables you to enter a corner radius for a round-cornered polygon

Smooth Corners Rounds the corners of the polygon

Indent Sides By Enables you to enter a percentage value to curve the sides
inward

Smooth Indents Rounds the indents

The Line Tool

When you select the Line tool, you can enter a value in the

Options bar for the weight of the line in pixels. Choices in the

Line Options panel determine the type of arrow that will 

appear at either end of the line. Select the Start or End check

boxes, or both, to produce an arrowhead at the beginning

and/or end of the line (see Figure 8.28). Enter values in Width,

Length, and Concavity for these characteristics of the arrow-

head. Figure 8.29 demonstrates the variety of possibilities in

these settings.

To constrain the Rectangle or Round Rectangle to a square, or the Ellipse to a circle, hold

down the Shift key as you drag.
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Figure 8.27

Polygon examples
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The Custom Shape Tool

You can generate custom shapes with the Shape tool . With the Custom Shape tool

selected, the Options panel displays these options:

Unconstrained Manually determines the proportion of the shape as you draw

Defined Proportions Enables you to drag to constrain the proportion of the shape 

Defined Size Draws the shape at the size it was created

Fixed Size Enables you to enter values for the shape in the Height and Width fields

From Center Radiates the shape from a center point

The Options bar Shape list lets you choose from many predefined custom shapes. You

can create additional shapes with the Pen tool and save them to this list (see Figure 8.30).

The pop-up list provides commands that let you delete, reset, load, save, and replace

custom shapes, plus several palette-viewing options. The options at the bottom rung of

the list replace the default list with additional shapes. With the All option, you can view a

comprehensive list of all available shapes.

P L A C I N G  C U S T O M  S H A P E S  O N  A N  I M A G E

Applying predefined custom shapes is a snap. First, open an image or create one; then take

the following steps:

1. Choose a foreground color.

2. Make a new empty layer by clicking the New Layer icon in the Layers palette.

3. Click the Shape tool in the Tool palette.

4. In the Options bar, click the Custom Shape icon to display the Shape Options panel.

Click the Unconstrained radio button.

5. In the Options bar, click the Shape list arrow to display the default custom shapes.

Click the arrow on the panel to display the list of commands in the drop-down sub-

menu; choose All to load all the additional shapes.

Figure 8.29

Examples of lines,
with and without

arrowheads
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Arrowhead 
characteristics
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6. Click a shape in the Shape list. Place your cursor on the image, click, and drag until

the shape is the size and proportion you want. To reposition the shape, press the

spacebar while dragging. Then release the mouse.

7. Optionally, choose additional shapes from the Shape list and

repeat for all the shapes you want on your image layer. Your

result might look like Figure 8.31.

D E F I N I N G  C U S T O M  S H A P E S

To create your own custom shape, follow these steps:

1. Use one of the Pen tools and draw a shape outline.

2. Choose Edit ➔ Define Custom Shape.

3. Select the Custom Shape tool. The new shape appears in the

Shape list in the Shape Tool Options bar.

Figure 8.30

The Shape list
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Figure 8.31

El Jefe adorned with
custom shapes
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